
NRC STAFF
USER'S GUIDE FOR PROTOTYPE OF TECHNICAL

REFERENCE DOCUMENT DATABASE SYSTEM
(TDOCS)

Prepared for

Nuclear Regulatory Commission
Contract NRC-02-93-005

Prepared by

Aaron R. DeWispelare
Joseph H. Cooper
Robert L. Marst.lI
Jennie S. Paddock

Center for Nuclear Waste Regulatqry Analyses
San Antonio, Texas I'

August 1995



CONTENTS
Section Page

FIGURES........................................................................... v
ABBREVIATIONS ..................... vii
ACKNOWLEDGMENTS ................. ix

1 INTRODUCTION . . . 1-1
1.1 ADVANCED COMPUET SYSTEM AND DOCUMENT MANAGEMENT.. 1-1
1.2 TECHNICAL REFERENCE DOCUMENT DATABASE SYSTEM

DOCUMENT SETS .. 1-1
1.3 PRIMARY FUNCTIONS .. 1-2

1.3.1 Searching and Retrieving Records .1-2
1.3.2 Displaying and Printing Records .1-2
1.3.3 Using Cut and Paste Facilities .1-2

2 GUIDELINES FOR USER ACCESS TO THE TECHNICAL REFERENCE
DOCUMENT DATABASE .................. 2-1
2.1 TYPOGRAPHIC CONVENTIONS .. 2-1
2.2 DEFINITIONS .. 2-1
2.3 GRAPHICAL USER INTERFACE CONTROLS AND FEATURES . .2-2
2.4 SOURCES OF ASSISTANCE .. 2-7
2.5 GETTING STARTED .. 2-7
2.6 TECHNICAL DOCUMENT DATABASE MAIN MENU . .2-7
2.7 MAIN MENU-OPERATIONS ENTRY .2-8
2.8 MAIN MENU-SEARCH ENTRY .2-9

2.8.1 Accessing the Full-Text Search Facilities .2-9
2.8.2 TOPIC Main Menu .2-10
2.8.2.1 TOPIC Main Menu-File Entry .2-11
2.8.2.2 TOPIC Main Menu-Edit Entry .2-19
2.8.2.3 TOPIC Main Menu-View Entry .2-22
2.8.2.4 TOPIC Main Menu--Query Entry .2-24
2.8.2.5 TOPIC Main Menu-Launch Entry .2-29
2.8.2.6 Formulating Simple Queries .2-30
2.8.3 Entering a Simple Query .2-31
2.8.4 Entering Form Queries .2-32
2.8.4.1 Selecting the Form Query Entry Mode .2-32
2.8.4.2 Using a Form Query .2-33
2.8.5 Selecting Documents for Viewing from the Results List .2-33
2.8.6 Viewing Selected Documents .2-35
2.8.7 Launching WordPerfect .2-38
2.8.8 Displaying Images .2-38
2.8.9 Exiting From the Record Search Facility .2-40

2.9 MAIN MENU-HELP ENTRY .2-40

3 REFERENCES. 3-1

APPENDIX

ERROR MESSAGES A

iii



FIGURES
Figure Page
2-1 Sample screen for Unix workstation ........................................... 2-5
2-2 Sample screen for DOS Windows-TDOCS desktop group icon ..................... 2-6
2-3 Sample screen for DOS Windows-TDOCS application icon ....................... 2-6
2-4 TDOCS main menu .............................................. 2-8
2-5 Operations pull-down menu .............................................. 2-8
2-6 Search-pull-down menu .............................................. 2-9
2-7 Search-TDOCS cascading menu ............................................ 2-10
2-8 TOPIC main menu-query entry screen ....................................... 2-11
2-9 TOPIC-File pull-down menu .............................................. 2-12
2-10 TOPIC-Open Query screen .............................................. 2-14
2-11 TOPIC-Save Query screen ............................................... 2-14
2-12 TOPIC-Page Setup screen .............................................. 2-15
2-13 TOPIC-Print screen .............................................. 2-16
2-14 TOPIC-close screen .............................................. 2-18
2-15 TOPIC-exit screen .............................................. 2-19
2-16 TOPIC-Edit pull-down menu .............................................. 2-20
2-17 TOPIC-View pull-down menu ............................................. 2-22
2-18 TOPIC-Sort Specification screen ........................................... 2-23
2-19 TOPIC-Query pull-down menu ............................................. 2-24
2-20 TOPIC-Assists options screen .............................................. 2-26
2-21 TOPIC-Query Type cascading menu ........................................ 2-26
2-22 TOPIC-query Options screen .............................................. 2-27
2-23 TOPIC-Source Selection screen ............................................ 2-28
2-24 TOPIC-Launch pull-down menu ........................................... 2-29
2-25 TOPIC entry screen for form queries ........................................ 2-32
2-26 TOPIC-query results list .............................................. 2-34
2-27 TOPIC-document display .............................................. 2-36
2-28 TOPIC-Navigation pull-down menu ......................................... 2-37
2-29 TOPIC-navigation facilities-Find Text entry screen ........................... 2-38
2-30 TOPIC-document display .............................................. 2-39
2-31 TOPIC-image display .............................................. 2-39
2-32 TDOCS-Help pull-down menu ............................................. 2-40
2-33 Help Index window ............................................... 2-41

v



ABBREVIATIONS

ACS Advanced Computer System

CNWRA Center for Nuclear Waste Regulatory Analyses

DWM Division of Waste Management

GUI Graphical User Interface

HLW High-Level Radioactive Waste

NIST National Institute of Science and Technology

NMSS Office of Nuclear Material Safety & Safeguards

NRC Nuclear Regulatory Commission

NTD NRC Technical Document

NUREG Nuclear Regulatory Commission Technical Documents

STP Staff Technical Position

TDI Technical Document Index

TDOCS Technical Reference Document Database System

vii



ACKNOWLEDGMENTS

This report was prepared to document work performed by the Center for Nuclear Waste Regulatory
Analyses for the Nuclear Regulatory Commission under Contract No. NRC-02-93-005. The activities
reported here were performed on behalf of the NRC Office of Nuclear Material Safety and Safeguards,
Division of Waste Management. The report is an independent product of the CNWRA and does not
necessarily reflect the views or regulatory position of the NRC.

The following trademarks are used in this report:

* MOTIF is a trademark of Open Software Foundation

* TOPIC is a trademark of Verity, Inc.

* Windows is a trademark of Microsoft Corp.

* WordPerfect is a trademark of WordPerfect Corp.

The Technical Reference Document Database System has been developed in accordance with the software
control and documentation requirements of the CNWRA Quality Assurance Manual.

ix



1 INTRODUCTION

1.1 ADVANCED COMPUET SYSTEM AND DOCUMENT MANAGEMENT

The Office of Nuclear Material Safety & Safeguards (NMSS) Advanced Computer System
(ACS) provides Nuclear Regulatory Commission (NRC) staff with the computer hardware and software
resources to analyze and display spatial and temporal data; construct topology feature models; compile and
run a variety of engineering and scientific programs: and access large volumes of data that have been
obtained from licensees and other public sources such as the United States Geological Survey, the National
Climatic Data Center, and other such databases. The Technical Reference Document Database System
(TDOCS) is a special software application that has been loaded on the ACS to provide full text search and
retrieval of those technical documents that have been loaded into a special document database; to reference
two major NMSS/DWM technical reference document files; and to reference other specialized document
databases maintained by the Center for Nuclear Waste Regulator Analyses (CNWRA).

1.2 TECHNICAL REFERENCE DOCUMENT DATABASE SYSTEM
DOCUMENT SETS

The following describes some of the document sets of the TDOCS. Text search and retrieval
facilities are provided for each document set.

* NRC full-text Technical Document (NTD) database-Maintained by Division of Waste
Management (DWM) staff consisting of technical documents submitted by the NRC staff.

* Hydrology database-Maintained by the (DWM) staff. This technical document database is
in the form of bibliographic references with some abstracts and reviews.

* NIST/Materials database-Maintained by the DWM staff. This database consists of an index
of approximately 1,000 bibliographic references. This database also contains 110 reviews of
Department of Energy documents associated with 20 data fields that permit access to the
contents of pertinent technical information and reviewer comments.

* NUREG database-A sample collection of selected NUREG documents.

* Regulations and Staff Technical Positions (STP)-A collection of NRC regulations and
STPs. Search and retrieval facilities are provided.

* Technical Document Index (TDI)-An index of technical documents in the library of the
CNWRA. In addition to search and retrieval, the TDI facilities provide circulation control of
physical documents. These documents are stored and maintained at the CNWRA in San
Antonio, Texas.

* CNWRA reports database-A sample collection of reports produced by the CNWRA.

Access to these document sets is accomplished by selecting the preferred set from a menu. The
user interface permits information access from the TDOCS application across all document sets. A
document database custodian/administrator adds or changes information in a database.
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1.3 PRIMARY FUNCTIONS

This section discusses the functions available to users of the TDOCS.

1.3.1 Searching and Retrieving Records

There are two ways to search and retrieve data records using the TDOCS: (i) individual words or
phrases may be entered into the full-text search interface to locate documents that contain those words or
phrases, and (ii) words or phrases may be entered to search for occurrences of those words or phrases in
specific fields, such as the title.

1.3.2 Displaying and Printing Records

After being selected, a record can be displayed on the screen and scrolled through to permit
viewing of the entire record. The record may also be printed.

1.3.3 Using Cut and Paste Facilities

Cut and paste capabilities are provided to users of the full-text search and retrieval facilities. Cut
and paste permits copying of relevant text in documents found through search and retrieval. Information in
the source document can be highlighted and copied electronically to other work products using the system
clipboard and a word processor application. From the word processing application, the text may be saved,
incorporated into other documents, or printed.
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2 GUIDELINES FOR USER ACCESS TO THE TECHNICAL
REFERENCE DOCUMENT DATABASE

The previous chapter provided a general introduction to the TDOCS and its primary functions. This
chapter provides the basic information needed to use the TDOCS.

The TDOCS has been designed to support users with all levels of computer experience. For security
reasons, access to the TDOCS is restricted to NRC and CNWRA staff members with appropriate User-lDs.
Help is available from system menus or from the CNWRA Help Desk at (210) 522-5258, or the NRC
System Administrator (301) 415-8087.

2.1 TYPOGRAPHIC CONVENTIONS

Throughout the User's Guide, the following typographic conventions are used:

* Screen menu names, menu items, and push-button names appear in italics with initial caps
or as they appear on the screen

Example: Select TDOCS from the menu bar of the TDOCS Main Menu.

* User input and system prompts appear in bold Courier typeface

Example: Enter the path and file name: c: \wp51\wp. exe

* Keystroke input from the keyboard appears as initial caps inside square brackets

Example: Press [Fl], then [Return]

* Keystroke input from the keyboard using combinations of keys (e.g., hold down the Ctrl
key and press H) appears as initial caps inside square brackets

Example: Press [Ctrl+H]

2.2 DEFINITIONS

Following are some basic definitions for use with graphical user interfaces (GUIs). Further
information about the standard GUIs for MOTIF and Microsoft Windows may be found in OSF/MOTIF
Style Guide (Open Software Foundation, Inc., 1993), and Using Windows (Que Corporation, 1994).

Accelerator keys An alternate method of selecting menu items that is similar to mnemonics.
However, unlike mnemonics, the accelerator keys may be used even when the
pull-down menu is not displayed. For an example see Figure 2-9.

Click Objects in GUI applications are normally selected by using the mouse to position
the cursor over the object and then pressing one of the mouse buttons. When the
mouse button is depressed it makes a clicking sound. Thus, the selection process
is often described as "clicking" on the object.
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Drag

GUI

Many objects in a GUI presentation may be moved around on the screen. This is
done by positioning the cursor over the desired object, depressing and holding the
mouse button, moving the cursor to the new location, and releasing the mouse
button. As the cursor is moved with the mouse button depressed, the selected
object follows the cursor movements. Thus, the object is "dragged" to the new
location.

A GUI is a presentation of information on a computer screen that takes advantage
of high-resolution graphics and usually employs a mouse, menu bars and other
types of menus, overlapping windows, and icons.

Alphabetic characters, indicated by an underscore that may be keyed to select the
desired options rather than using the mouse. For example, the option in the
Operations pull-down menu that permits the user to exit the TDOCS is
represented by the menu entry "Exit." Either select this entry with the mouse or
key the mnemonic, "x".

A commonly used pointing device that has one or more buttons. When the mouse
is moved, the cursor moves in a corresponding manner on the screen. When one of
the mouse buttons is pressed, a signal is sent to the program that results in some
interaction with the system.

Mnemonics

Mouse

Mouse button A button on a mouse that sends a signal to the system when pressed. Mouse
buttons are used to select choices, initiate actions, or manipulate objects on the
screen.

Select Position the cursor on top of the item to be selected (e.g., menu name, button,
icon, etc.) and press (or click) the left mouse button.

2.3 GRAPHICAL USER INTERFACE CONTROLS AND
FEATURES

Cascading menu An area to the left or right of an entry in a pull-down menu that expands the
options or functions available for that entry. Cascading menus provide a way to
layer choices so that a user can have access to a wide range of functions without
being confused by lengthy lists of choices. Selecting an entry in a cascading menu
causes the related system function(s) to be performed.

Cursor A visual cue that indicates where the next interaction with the computer screen
will take place. Cursors are moved by the mouse or the cursor keys and provide a
way to select and interact with things that appear on the screen.

Drop-down list

Entry field

A variation of the list view in which only one item in the list is displayed until an
action is taken to display the rest of the list. Drop-down lists are used in situations
where a list view is needed but would crowd the window if always present.

A location in a screen where entry or alteration of textual or numeric information,
such as a file name, password, or version number, is allowed. Entry fields may
accommodate single words or numbers, or single or multiple lines of text.
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Group box

Help screen

Icon

List view

Maximize button

An area in a screen that contains related information and controls. Group boxes
are usually surrounded by a labeled square or rectangular line.

A screen that contains information about how to use the system, recover from
problems, select available choices, etc. Help screens can be used for assistance
while learning to use the system. They can also serve as a refresher for users who
have not accessed the system regularly or recently.

A small image that represents a function or data object.

A read-only field with one or more scroll bars that contains multiple entries. The
list view is used to display a fixed or variable list of values, fields, or options (e.g.,
the list of all documents). Because the display area in a list view can be scrolled,
the list can contain more items than can be displayed at one time in the display
area.

A control in the upper right-hand corner of the window that expands the window
to its maximum size.

Menu

Menu bar

Messages

A presentation of options.

An area extending across the top of a window below the window title that lists the
menu entries. Selecting these menu entries causes either the related system
functions to be performed or a pull-down menu with additional entries and options
to be displayed. The existence of a pull-down menu is usually indicated by a small
downward-pointing arrow or triangle at the right-hand side of an entry in the
menu bar.

Information displayed when there is a particularly important or urgent condition
in the software in use. Messages often contain not only a description of a problem
but also an explanation of how to correct the situation. They may also contain
selections that assist in deciding how to continue working.

Minimize button A control in the upper right comer of the window that shrinks the window to an
icon.

Pane A defined area within a window that is used as a separately scrollable area.
Windows are sometimes divided into two or more panes so that different but
related information may be displayed and scrolled independently.

Pull-down menu A list of options extending below an entry in a menu bar that is displayed when a E

menu bar entry is selected. Pull-down menus contain choices and functions that "
are related to each other in some manner. Typically they contain additional menu
entries and/or options related to the "parent" entry on the menu bar. Selecting an
entry in a pull-down menu causes either the related system functions to be
performed or a cascading menu with additional entries and options to be
displayed.
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Push-button

Radio buttons

Sash line

Scroll bar

Sizing buttons

Title bar

Window

A labeled, rectangular or oval "button" that causes an action to be taken when it is
selected. When a push-button is selected (e.g., by pressing the left mouse button
when the cursor is over the push-button), it is shaded and appears to be depressed.
The push-button remains shaded until the action is completed and then returns to a
"normal," deselected appearance.

Two or more related button controls that permit selection of mutually exclusive
options. The selected option is shaded and appears to be depressed. When a
different option is selected, the radio button for that option is shaded and
depressed, and the previously selected radio button returns to a "normal,"
deselected appearance.

A bold line separating two panes within a window.

A control, usually positioned at the right-hand side or bottom of a window, that
permits the contents of the window to be moved horizontally or vertically within
the window.

Controls in the corners of the window that can be used to change the size and
shape of the window.

An area at the top of the window containing a brief title of the window. Pressing
the left mouse button when the cursor is in the title bar and "dragging" it moves
the window to a new position on the screen.

An area on the screen where data, icons, controls, etc. can be viewed. A window is
bounded by a window border that separates the window from other windows on
the screen. The window size and its contents may be changed and controlled by
using a number of controls in the window border.

The TDOCS has been implemented in a multiplatform environment allowing it to be accessed by
users in diverse hardware/software environments. While the TDOCS functions in the same way in all of
the supported hardware/software environments, the look and feel of the system will vary slightly.
Figures 2-1 and 2-2 illustrate the typical appearance of a sample Sun MOTIF and Microsoft Windows
hardware/software platforms.

If Sun Microsystems equipment is used, the TDOCS will be accessed through the MOTIF GUI.
Figure 2-1 illustrates the menu item (button) used to access the TDOCS. If IBM or IBM-compatible
equipment is used, the TDOCS can be accessed through Microsoft Windows. Figure 2-3 illustrates the
appearance of a sample screen showing the icon used to access the TDOCS.

The functionality of the TDOCS and the general appearance of the user interface is the same,
regardless of the hardware/software environment. However, the specific details of the screens in a specific
interface vary slightly to conform to the standard look and feel of the hardware/software environment. The
MOTIF environment has been selected for the screens presented in this User's Guide.
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Figure 2-1. Sample screen for Unix workstation
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I File Options Window Help I

Figure 2-2. Sample screen for DOS Windows-TDOCS desktop group icon

--- - --~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ I ]j-:?:']

I Eile Qptions Window Help I

Figure 2-3. Sample screen for DOS Windows-TDOCS application icon
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AU of the hardware/software environments employ a mouse to permit the user to quickly select
options and traverse menus. Communication with the system is accomplished by using the mouse to
position the cursor, and pressing the left mouse button (except when the specific hardware/software
environment requires use of the right button) to select the desired option. Most menu entries also include
mnemonics and accelerator keys.

2.4 SOURCES OF ASSISTANCE

There are a number of sources that can provide assistance to the user:

* Help Screens-Help that can be activated by positioning the cursor and selecting the
HELP button or menu entry is provided for each screen display.

* Training-Training for all NRC and CNWRA staff will be provided. Additionally,
periodic training for new staff and retraining for any other staff will be provided on
request.

* Assistance-Telephone assistance is available by calling the CNWRA Help Desk at
(210) 522-5258, or the NRC System Administrator at (301) 415-8087.

2.5 GETTING STARTED

To get started, a proper workstation with the client TDOCS software installed is required. The
program is executed by clicking on the program icon. While using the TDOCS, various system status and
error messages may be displayed to alert the user to conditions detected by the program. Many of these
messages appear in their own windows, and must be cleared before continuing by selecting a push-button
at the bottom of the message window. The wording of the messages, their meaning, and appropriate
responses are described in Appendix A.

The TDOCS is normally started by selecting it on the screen display.

1. On a Windows workstation, double click on the program icon on the Windows desktop.

On a Sun workstation, position the cursor on the desktop area of the screen and press the
right mouse button (for MOTIF environment). A pull-down menu of functions appears.

2. Select TDOCS. The system starts the TDOCS.

2.6 TECHNICAL DOCUMENT DATABASE MAIN MENU

After the TDOCS has been successfully started, the TDOCS Main Menu screen is displayed
(Figure 2-4). The menu bar in this screen contains the major functions that the user is permitted to perform.

For all users, the following entries appear in the menu bar of the TDOCS Main Menu:

Operations-Exit from the TDOCS

Search-Use full-text and/or fielded information searches to find and access TDOCS records

Help-Access the TDOCS help facilities to get more information about how to use the TDOCS
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Functions may be selected by positioning the cursor on the menu bar of the TDOCS Main Menu
and selecting the desired entry. Depending on the function selected, either a pull-down menu is displayed
or the function selected is automatically executed.

Mnemonics, where applicable, are available to facilitate selection of entries from the menus.
Mnemonics are alphabetic characters, indicated by an underscore, that may be keyed to select the desired
options rather than using the mouse. Accelerator keys (e.g., [Ctrl+H] or [AH]) are also available, and
provide an alternate method of selecting functions from the pull-down menus under the main menu entries.

2.7 MAIN MENU-OPERATIONS ENTRY

The Operations main menu entry permits performance of general functions that are available to
all users. Selecting Operations from the menu bar of the TDOCS Main Menu (Figure 2-4) causes the
Operations pull-down menu (Figure 2-5) to appear.

To exit from the TDOCS:

1. Select Operations from the menu bar of the TDOCS Main Menu (Figure 2-4). The system
displays a pull-down menu (Figure 2-5).

2. Select the Exit entry from the Operations pull-down menu. Alternatively, the mnemonic
[x] may be typed or the accelerator key [F3] pressed. The system closes the users security
permissions and authorities and terminates the TDOCS session. At this point, the TDOCS
has been successfully exited. To use the TDOCS again, select the TDOCS entry on the
desktop screen.

Figure 2-4. TDOCS main menu

Figure 2-5. Operations pull-down menu
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2.8 MAIN MENU-SEARCH ENTRY

The TDOCS provides powerful and easy-to-use facilities for identifying and viewing records.
The TOPIC full-text search and retrieval software is used to find the TDOCS records by searching for
specific words or phrases in: (i) the text of the document, or (ii) certain document header fields, such as the
title or author.

2.8.1 Accessing the Full-Text Search Facilities

The following steps are required to search for TDOCS records:

1. Select the Search entry from the menu bar of the TDOCS Main Menu (Figure 2-4). The
system displays the Search pull-down menu (Figure 2-6).

2. Select the TDOCS entry from the Search pull-down menu. The TDOCS cascading menu
displays (Figure 2-7). This menu permits selection of the type of TDOCS records to
search.

3. Select the desired group of TDOCS records to be searched from the Search pull-down
menu. The system starts the TOPIC full-text search and retrieval facilities to access the
selected group of TDOCS records and displays a TOPIC Query Entry screen for simple
queries (Figure 2-8). It takes a few seconds for the TOPIC full-text search and retrieval to
be started, and several information and copyright screens display before the first TOPIC
Query Entry screen appears.

If a message appears indicating some sort of problem with configuration and/or some of
the parameters needed by the TOPIC software, document the message by pressing the
[Print Screen] key, and then, contact the CNWRA Help Desk at (210) 522-5258 or the
NRC System Administrator at (301) 415-8087.

When the TOPIC full-text search facility has been started, two windows are displayed. The
background window is the TOPIC Main Menu, which contains a menu bar that permits selection of options
pertaining to the query. The foreground window is the TOPIC Query Entry screen (Figure 2-8). This
window permits entry of words and/or phrases to be used in searching for records. The name of the current
query appears in the shaded title bar at the top of the TOPIC Main Menu screen. New queries have default
names such as Untitled-l, Untitled-2, etc.

Figure 2-6. Search-pull-down menu
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Figure 2-7. Search-TDOCS cascading menu

2.8.2 TOPIC Main Menu

The following sections discuss items from the TOPIC Main Menu along with their associated
pull-down menus. The intent is to provide a basic introduction to the capabilities of the TOPIC full-text
search and retrieval product. Only selected features of the TOPIC full-text search and retrieval software are
discussed in this User's Guide. For further information, see the appropriate TOPIC user's guide for the
hardware/software platform or call the CNWRA Help Desk at (210) 522-5258 or the NRC System
Administrator (301) 415-8087.

The presentation of the TOPIC Main Menu is slightly different, depending on which platform is
being used. However, the functionally is essentially the same. The menu bar of the TOPIC Main Menu
(Figure 2-8) contains entries that provide access to a number of capabilities of the TOPIC full-text search
and retrieval software. The TOPIC Main Menu bar options are:

Eile Start new queries and save the current query

Edit-Cut, copy, paste, and search for specific text in a document display

View-View different document displays

Query-Change the type of query
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Figure 2-8. TOPIC main menu-query entry screen

Launch-Start other programs such as WordPerfect

Help-Get additional Help information

2.8.2.1 TOPIC Main Menu-File Entry

When the Eile entry in the TOPIC Main Menu is selected, the file pull-down menu appears
(Figure 2-9). This pull-down menu contains the following options:

New Query-Begin a new query definition

Qpen Query-Open a previously defined and saved query so that it may be used and/or modified

Open Selectionpen a selected item into a new window

Save Query-Save the current query so that it may be used again and/or modified in the fuiture
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Figure 2-9. TOPIC-File pull-down menu

Save As-Save the current query using a specified file name

Save Topics-Save changes made to the TOPIC database during the current session

Glet Info-Display a window containing additional information about a selected document

Query Manager-Display a window containing a list of the available queries

Page Setyp-Change the printer, margins, and/or page size used when printing information
directly from TOPIC

Erint-Print information from the currently selected TOPIC screen

Close-Close the currently selected TOPIC query screen

Ejit-Close all TOPIC query screens and exit from TOPICs full-text search and retrieval system

Those TOPIC options which are most commonly used in the TDOCS are discussed as follows.
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TOPIC File Puff-down Menu-New Query Entry

The New Query entry in the Eile pull-down menu (Figure 2-9) permits start of a new query. If an
existing query is active, that screen remains but an additional new query screen is created. The options
selected in the TOPIC preference file determine the initial settings of query screens. Normally, a new query
is started as a simple query. If a different type of query screen is desired, (e.g., a form query), change the
query type by selecting the Query entry from the TOPIC Main Menu. (For a further discussion of how to
select a different query type, see Section 2.8.2.4.)

To start a new query:

1. Select the Eile entry from the menu bar of the TOPIC Main Menu. The Eile pull-down
menu appears.

2. Select the New Query entry from the Eile pull-down menu. A new screen is created using
the default query type (normally a simple query).

3. To access a different type of query screen, use the Query entry in the TOPIC Main Menu
to change the query type (see Section 2.8.2.4).

TOPIC File Pull-down Menu-Open Query Entry

The Qpen Query entry in the Eile pull-down menu permits retrieval of the definition of an
existing query that was previously stored. If an existing query is active, that screen will remain but a new
query screen will be created for the query that is being retrieved. The options selected for the existing
query that is being opened will determine the initial settings of the query screen.

To open an existing query:

1. Select the Eile entry from the menu bar of the TOPIC Main Menu. The Eile pull-down
menu appears.

2. Select the Qpen Query entry from the Eile pull-down menu. An entry screen appears to
permit location and selection of the name of the query definition file (Figure 2-10).

TOPIC File Pull-down Menu-Save Query Entry

The Save Query entry in the Eile pull-down menu permits definition of the current query to be
saved so that it can be retrieved and used in the future. The Save Query entry is normally used to save and
update the definition of a named query that had been previously saved. The query name will not be
changed. If the entry is used for a new query, a prompt will request the path and file name for the query
(See Figure 2-11).

To save an existing query:

1. Select the Eile entry from the menu bar of the TOPIC Main Menu. The File pull-down
menu appears.

2. Select the Save Query entry from the Eile pull-down menu. If a previously named query is
being saved, the query definition is saved, and no further action is required.

If an unnamed query is being saved, one that has not previously been saved, an entry
screen appears so that a path and file name for the query definition can be selected.
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TOPIC File Pull-down Menu-Save As Entry

The Save as entry in the Eile pull-down menu permits the definition of the current query to be
saved with a new name, so that it can be retrieved and used in the future. The Save As entry is normally
used to save an existing query definition, which has been updated, with a new name.

To save an existing query using a new name:

1. Select the Eile entry from the menu bar of the TOPIC Main Menu. The Eile pull-down
menu appears.

2. Select the Save As entry from the File pull-down menu. An entry screen appears so that a
path and file name may be selected for the query definition (Figure 2-11).

3. Select the desired path and enter the desired file name for the query. If possible, the name
of the query should be descriptive and meaningful to support easy retrieval.

4. Select the OK push-button at the bottom of the entry screen to save the query.

TOPIC File Pull-down Menu-Page Setup Entry

The Page Setyp entry in the File pull-down menu permits options to be set, including page
height, page width, and margins, that control the appearance of printed information produced by TOPIC.

To change the options for the setup of printed pages:

1. Select the Eile entry from the menu bar of the TOPIC Main Menu. The Eile pull-down
menu appears.

2. Select the Page Setup entry from the Eile pull-down menu. An entry screen appears so that
page setup options may be entered and/or changed (Figure 2-12).
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3. Enter the desired values in the entry fields for Page height, Page width, Left margin, Right
margin, Top margin, and Bottom margin.

4. Select the OK push-button at the bottom of the entry screen to save the page setup options.

5. Select the Cancel push-button at the bottom of the entry screen to exit from the Page Setup
entry screen without updating the page setup options.

TOPIC File Pull-down Menu-Print Entry

The Erint entry in the Eile pull-down menu permits setting of options that control printing
information produced by TOPIC.

To change the options for printing:

1. Select the Eile entry from the menu bar of the TOPIC Main Menu. The File pull-down
menu appears.

2. Select the erint entry from the File pull-down menu. An entry screen appears so that print
options can be entered and/or changed (Figure 2-13).

3. Enter the system name of the desired printer device in the Printer entry field. Contact the
CNWRA Help Desk at (210) 522-5258, or the NRC System Administrator at
(301) 415-8087 for specific information on printer devices.

4. Select the option button for Print all to indicate whether to print the entire document or
just selected pages. If the Print all button is depressed, the entire document is printed. If
the Print all button is not depressed, only the specified pages of the document is printed;
the beginning page must be entered in the From entry field and the ending page in the To
entry field.

Pnnler:

PH RI all: m Fhan: To:
^. ................... ., .. >.,, ......,M,, ......
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Let s inghI

Top ib tHWlb

OK T s

Figure 2-13. TOPIC-Print screen
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5. Select the appropriate Print order button to print the document Left to right or Top to
bottom.

The print order selections Left to Right and Top to Bottom only pertain to the printing of
images. For images that are larger than a single page (i.e., span multiple pages), the order
in which the image page segments print can be specified by selecting either the Left to
Right or the Top to Bottom print order. Examples are provided below.

Left to Right-The document to be printed contains an image that spans six pages. The
Left to Right print order is selected. The image page segments are printed in the order
indicated below.

Top to Bottom-The document to be printed contains an image that spans six pages. The
Top to Bottom print order is selected. The image page segments are printed in the order
indicated below:

1 3 5

2 4 6
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6. Select the OK push-button at the bottom of the entry screen to print the document and save
the print options.

7. Select the Cancel push-button at the bottom of the entry screen to exit from the Print
options screen without printing the document.

TOPIC File Pull-down Menu-Close Entry

The Close entry in the Eile pull-down menu permits closing of the current query window without
exiting TOPIC. When the window is closed, TOPIC will display a screen that permits the current query to
be saved or discarded (Figure 2-14).

To close the current query window:

1. Select the Eile entry from the menu bar of the TOPIC Main Menu. The Eile pull-down
menu appears.

2. Select the Close entry from the Eile pull-down menu. A screen appears that provides a
choice of either discarding or saving the current query.

3. Select the Save push-button to save the current query. This causes the TOPIC Save Query
screen to appear (Figure 2-11).

4. Select the Discard push-button to close the current query screen without saving the query.

5. Select the Cancel push-button to exit from the Close options screen without closing the
current query.
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Figure 2-14. TOPIC-close screen
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TOPIC File Pull-down Menu-Exit Entry

The Fxit entry in the Eile pull-down menu permits closing of all active current query windows
and exit from TOPIC. When the last window is closed, TOPIC will display a screen that permits the user to
exit or open a new query window (Figure 2-15).

To exit TOPIC:

I. Select the Eile entry from the menu bar of the TOPIC Main Menu. The Eile pull-down
menu appears.

2. Select the Exit entry from the File pull-down menu. When the last active query window
has been closed, a screen appears that allows a choice of exiting or of opening a new query
window.

3. Select the Exit push-button to exit TOPIC.

4. Select the New window push-button to open a new query window and stay in TOPIC.

2.8.2.2 TOPIC Main Menu-Edit Entry

When the Edit entry is selected from the menu bar of the TOPIC Main Menu, the Edit pull-down
menu appears (Figure 2-16). This menu contains the following options:

Undo-Reverse the previous operation to undo its effects

Cut-Remove the highlighted text and copy it to a temporary area called the clipboard

Copy-Copy the highlighted text to the clipboard

Paste-Insert the contents of the clipboard at the location of the cursor

Last window closed. Exit TOPIC?

I El ..-.-.

Figure O xtow

Figure 2 15. TOPIC--exit screen
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Clear Selection-Clear the selected TOPIC, document, etc., in a window

Delete Selection-Delete the selected topic, document, etc., from the TOPIC database

Select A 11-Highlight the entire text of the area identified by the cursor

Add to Query-Add current query selections to an existing named query

The TOPIC Edit pull-down menu is illustrated in Figure 2-16. Those TOPIC options which are
most commonly used in the TDOCS are described below.

TOPIC Edit Pull-down Menu-Undo Entry

The Undo entry in the Edit pull-down menu permits reversing of the previous action. The Undo
option is not always available because some actions do not lend themselves to being reversed. In these
circumstances the Undo option is grayed to indicate that it is not available. When the Lindo option is
available and is selected, the system is restored to its state before the previous operations. For example, if a
Select a1l operation had been performed, the entire document would be highlighted. Selecting the UCndo
option would reverse, the highlighting resulting from the Select All option.
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Figure 2-16. TOPIC-Edit pull-down menu

-oo.: ..0N .'~x a::: ..: -% ne ' : _emzemx -v r:::,::x~~x- '' .: ,: .:: >: x ~ x -. >l

kTE TITLE I
* . N ,.l .Y...,:*:..'*i . .Z . >:.:.x: :::'w..,.. . '. :: >>: :. : :':. ".'.:... :'...

._ I ,

FundamenIab of Earthquae R
CSIVIIP Stron-Mation Rec I

j Evauation of RPk Joint ModM_ _ _ _ _ _ _ _ _ _ _ _ _ __- - - - - -

2-20



TOPIC Edit Pull-down Menu-Cut Entry

The Cut entry in the Edit pull-down menu permits the user to remove highlighted text from the
document and insert it in a temporary area called the clipboard. After text has been inserted into the
clipboard by either the Cut or Copy operation, it may be inserted into a document using the Paste
operation.

To use the Cut option:

1. Highlight the text that is to be cut by positioning the cursor at the first character,
depressing and holding the left mouse button, moving the cursor to the last character to be
cut, and releasing the left mouse button (click and drag).

2. Select the Cut option from the Fdit pull-down menu. The highlighted text is removed from
the current document and stored in the clipboard. A Cut operation replaces the previous
contents of the clipboard.

TOPIC Edit Pull-down Menu-Copy Entry

The Copy entry in the Edit pull-down menu permits the user to copy highlighted text from the
document and insert it in a temporary area called the clipboard. After text has been inserted into the
clipboard by the Copy operation, it may be inserted into a document using the paste operation.

To use the Copy option:

1. Click and drag to select the text for copying.

2. Select the Copy option from the Edit pull-down menu. The highlighted text is stored in the
clipboard. The Copy operation replaces the previous contents of the clipboard.

TOPIC Edit Pull-down Menu--Paste Entry

The Paste entry in the Edit pull-down menu permits insertion the contents of the clipboard at the
location of the cursor.

To use the paste option:

1. Position the cursor at the location where the contents of the clipboard is to be inserted and
click the left mouse button to establish the new cursor location.

2. Select the Paste option from the Edit pull-down menu. The contents of the clipboard is
inserted at the cursor location. The taste operation does not affect the contents of the
clipboard. Therefore, the contents of the clipboard may be pasted repeatedly at different
locations in the document.
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TOPIC Edit Pull-down Menu-Select All Entry

The Select All entry in the Edit pull-down menu permits highlighting of an entire document.

To use the Select All option:

1. Position the cursor on the document to be selected and click the left mouse button to
establish the new cursor location.

2. Select the Select A11 option from the Edit pull-down menu. The entire document is
highlighted to indicate that it has been selected and may be cut or copied.

2.8.2.3 TOPIC Main Menu-View Entry

The TOPIC View pull-down menu provides options for altering the appearance of the TOPIC
query and query results windows. When View entry is selected in the TOPIC Main Menu, the View
pull-down menu appears (Figure 2-17). The View pull-down menu contains the following entries:

Expand Selection-Expand the node for the selected topic, assists item, results folder, or group
to show more detail

Collapse Selection-Collapse the node for the selected topic, assists item, results folder, or group
to show less detail

Sort-Select sorting criteria to be used in sequencing the query results list

Tree-Change the layout of the topic query to a tree format

File Ed ie Quey Lunch

S~~~~~'L.. ~ ~ I.. -E Wer wW E.i&t| i. )VA soldan CMAear >
. SorL

as: I
A_,~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~

X.,1 "'
- ----------------------------- --------------- --- ... --------

__.. . I................. I

JI - ------ out r II
A l p s~~~~~~~~~~~~~~~~~~ 01E1 -- TITI_____

Figure 2-17. TOPIC-View pull-down menu
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Outline-Change the layout of the topic query to an outline format

The View pull-down menu is illustrated in Figure 2-17. Those TOPIC options that are most
commonly used in the TDOCS are described below.

TOPIC View Pull-down Menu-Sort Entry

A default sequence is defined for the query results lists. However, the results list sequence may
be altered by selecting the Sort option from the _LFiew pull-down menu.

To change the Sort sequence for the query results list:

1. Select the View entry from the TOPIC Main Menu. The View pull-down menu appears
(Figure 2-17).

2. Select the Sort entry from the fiew pull-down menu. A Sort Specification window appears
(Figure 2-18).

3. Select the Ascending or Descending radio button to specify ascending or descending
sequence for the sort.

4. Double clicking fields in the Sort by group box removes them from the sort. Another
method is to (i) highlight the field in the Sort by box that is to be removed and (ii) click the
Move button.

5. Double clicking fields in the Available fields group box adds them to the sort. Another
method is to (i) highlight the field in the Available fields box that is to be added and
(ii) click the Move button.
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Figure 2-18. TOPIC-Sort Specification screen
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6. Select the Set push-button to save the new sort sequence.

7. Select the Re-Sort push-button to apply the new sort sequence to the current results list.

8. Select the Cancel push-button to discard the changes to the sort sequence.

2.8.2.4 TOPIC Main Menu-Query Entry

The TOPIC Query pull-down menu provides a method of altering various options associated
with TOPIC queries. When the Query entry in the TOPIC Main Menu is selected, the Query pull-down
menu appears (Figure 2-19). The Query pull-down menu contains the following entries:

Start Retrieval-Start a query retrieval based on the current query defined in the query window

Cancel Retrieval-Cancel the current query retrieval
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Figure 2-19. TOPIC-Query pull-down menu
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Merge Results-Merge the results of a retrieval when results have been obtained from multiple
partitions

Assists-Open the Assists window to display topics, words, and stems contained in the TOPIC
database

Add Operator-Add an operator in a topic query

Add Child-Add a branch topic or a leaf topic to a selected parent

Add Sibling-Add a branch topic or a leaf topic as a sibling to a selected topic

Query Type-Change the type of query window

Query Options-Specify options for the query

Choose Sources-Select a source or set of sources to be used in retrievals

The Query pull-down menu is illustrated in Figure 2-19. Those TOPIC options that are most
commonly used in the TDOCS are described below.

TOPIC Query Pull-down Menu-Assists Entry

TOPIC includes a number of tools for assisting in formulating queries. These may be accessed
through the Assists entry in the Query pull-down menu.To access the Assists window:

1. Select the Query entry from the TOPIC Main Menu. The Query pull-down menu appears
(Figure 2-19).

2. Select the Assists entry from the Query pull-down menu. An Assists window appears
(Figure 2-20).

3. Select the desired Assists entry from the list in the Assists Window. See the TOPIC User's
Guide for more information on this option.

4. Click outside of the Assists window to close it.

TOPIC Query Pull-down Menu-Query Type Entry

TOPIC provides facilities for three types of queries including: (i) simple queries, (ii) form
queries, and (iii) topic queries. The type of query selected determines the appearance and format of the
query entry window. The desired type of query may be selected through the Query Type entry in the Query
pull-down menu.

To select the type of query:

1. Select the Query entry from the TOPIC Main Menu. The Query pull-down menu appears
(Figure 2-19).

2. Select the Query Type entry from the Query pull-down menu. A Query Type cascading
menu appears (Figure 2-21).
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3. Select the desired Query Type entry from the Query Type cascading menu by clicking the
desired entry in the cascading menu.

4. Click outside of the Query Type cascading menu to close it.

Instructions for entering simple queries and form queries may be found in
Sections 2.8.3 and 2.8.4.

TOPIC Query Pull-down Menu-Query Options Entry

TOPIC provides facilities for associating various options with queries. The query options may be
selected through the Query Qptions entry in the Query pull-down menu.

To select the query options:

1. Select the Query entry from the TOPIC Main Menu. The Query pull-down menu appears
(Figure 2-19).

2. Select the Query Qptions entry from the Query pull-down menu. A Query Qptions
window appears (Figure 2-22).
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Figure 2-22. TOPIC-query Options screen
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3. Select and/or enter the desired query options in this window.

4. Select the OK push-button to close the Query Qptions window and save the options that
have been entered and/or selected.

5. Select the Cancel push-button to close the Query Qptions window and discard the options
that have been entered and/or selected.

TOPIC Query Pull-down Menu-Choose Sources Entry

TOPIC provides facilities for limiting the scope of query searches to selected sets of documents.
These selected sets of documents are called "sources." By selecting one or more particular sources, the
number of documents searched may be limited and reduce the occurrences of unwanted documents from
extraneous sources in the search results list.

To select one or more sources:

1. Select the Query entry from the TOPIC Main Menu. The Query pull-down menu appears
(Figure 2-19).

2. Select the Choose Sources entry from the Query pull-down menu. A Source Selection
window appears (Figure 2-23).

3. Select one or more sources by clicking the entries in this window. Selected entries are
highlighted.

4. Select the OK push-button to close the Source Selection window and save the selected
sources.

5. Select the Cancel push-button to close the Source Selection window and discard the
selected sources.
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Figure 2-23. TOPIC-Source Selection screen
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2.8.2.5 TOPIC Main Menu-Launch Entry

The TOPIC Launch pull-down menu provides options for starting other programs and
functionality from TOPIC. When the Launch entry in the TOPIC Main Menu is selected, the Launch
pull-down menu appears (Figure 2-24). The Launch pull-down menu contains the following entries:

Import from File-Import a named file of retrieval results and display them in a query window

Export to File-Export the current retrieval results to a named file

Export Topic to File (User Modifications)-Export the modifications that have been made to a
topic to a named file

Export Topic to File (Full Definition)-Export the full definition of a topic to a named file

WordPerfect 5. 1-Start WordPerfect 5.1

Only the WordPerfect 5.1 option is described below.

TOPIC Launch Pull-down Menu-WordPerfect 5.1 Entry

TOPIC provides facilities for starting WordPerfect, using a file selected from the TOPIC full-text
database.

To start WordPerfect:

1. Select the Launch entry from the TOPIC Main Menu. The Launch pull-down menu
appears (Figure 2-24).

2. Select the WordPerfect 5.1 entry from the Launch pull-down menu. WordPerfect is
started.
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2.8.2.6 Formulating Simple Queries

TOPIC queries are formulated in a very intuitive manner. The following summary of TOPIC
syntax is intended to be an introduction that will permit the user to begin searching for records. Training
will be provided as required. For more information on TOPIC syntax, contact the CNWRA Help Desk at
(210) 522-5258 or the NRC System Administrator (301) 415-8087.

Enter words, phrases, or expressions to find the desired materials in the full-text database.

* Words-Enter a single word or multiple words separated by commas to formulate a
TOPIC query. Each word is used to individually to search for documents containing that
word. When multiple words (separated by commas) are entered, TOPIC retrieves
documents containing any of the specified words. Commas act as Boolean OR operators.

Words are considered to be stems in that endings are ignored. For example, if the word
market is entered, TOPIC selects documents that contain "market," "markets,"
''marketing," or "marketed."

To look for a specific word, enclose it in double quotation marks to prevent it from
matching as a stem.

Words are considered to be case insensitive. Thus, for search purposes words may be
entered in lowercase, uppercase, or mixed case.

* Phrases-Multiple words may be entered, without separating them with commas, and the
system treats them as phrases and retrieve only documents that contain corresponding
phrases.

To search for more than one phrase, separate the individual phrases with commas. For
example if the entry is, RADIOACTIVE WASTE, HIGH-LEVEL WASTE, the system
searches for documents containing either or both phrases.

Within phrases, TOPIC treats words as stems. Thus, if the search phrase entry is,
HIGH-LEVEL WASTE, TOPIC selects documents that contain the phrases:
(i) "high-level waste...," (ii) "high-level wastes...," (iii) "higher-level waste...," or
(iv) "higher-level wastes...."

To search for a specific phrase, enclose it in double quotation marks.

* Expressions-Indicate the required combinations of phrases and words by using special
words such as "and," "or," and "not" to combine the words and phrases into expressions.
When one of these reserved words is typed, TOPIC changes its appearance to indicate that
the reserved word is being interpreted as a logical operator rather than as a word. For
example, if the expression, WASTE AND CONTAINMENT is entered, the system
interprets the word "and" as an operator, and displays the query terms as WASTE <AND>
CONTAINMENT. This query would only retrieve documents that contain both the words
"waste" and "containment."
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To use a reserved word such as "and," "or," or "not" as a word in a phrase, it must be
enclose it in quotation marks to prevent the system from interpreting it as an operator. For
example, WASTE "AND" EMPLACEMENT would be interpreted as a phrase rather than
an expression because "and" is enclosed in quotation marks.

2.8.3 Entering a Simple Query

For simple queries, the TOPIC Simple Query Entry screen (Figure 2-8) permits the user to enter
words, phrases, and/or expressions to search and to view the resulting list of selected documents. The
TOPIC Simple Query Entry screen for simple queries contains an upper pane and a lower pane, separated
by a sash line. The upper pane contains an entry field that can be scrolled if necessary. Words and/or
phrases that are to be used for searching are typed into the entry field under the prompt: Enter words and
phrases separated by commas.

To enter a simple query:

1. Position the cursor in the Enter words and phrases, separated by commas entry field of the
upper pane of the TOPIC Query Entry screen for simple queries (Figure 2-8) and press the
left mouse button. This activates the entry field. If a vertical cursor bar does not appear in
the upper left-hand corner of the entry field, it may be necessary to move the scroll bar at
the right side of the entry field in order to position the cursor at the top of the entry field.

2. Type the desired word(s) and/or phrase(s) in the Enter words and phrases, separated by
commas entry field. Note that the entry field is initially set up to display only a few lines.
However, as many words and/or phrases can be entered as needed. If more information is
typed in than can be held on a single line, the words wrap automatically to the next line. If
more lines than can be displayed in the entry field are typed in, the text scrolls
automatically. To see text that has been typed in that is not currently visible in the entry
field: (i) move the vertical scroll bar at the right side of the entry field or (ii) make the
entry field larger by selecting and holding the dark bar below the entry field and then
dragging the bottom of the entry field downward.

3. When all of the desired search words, phrases, and/or expressions have been entered, start
the search either: (i) by pressing the [Return] or [Enter] key, or (ii) by selecting the
Retrieve push-button under the entry field. As the query is executed, several pieces of
status information are displayed: (i) a colored bar at the right side of the window, under the
entry field, fills from left to right to indicate how far the query has progressed; (ii) a
message at the left side of the window, under the entry field, which has the form
"Retrieved: 25 of 150" updates continuously to show how many documents have been
selected and how many have been examined by the query; and (iii) the results list in the
lower pane of the window fills from top to bottom with a description of the selected
records.
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2.8.4 Entering Form Queries

TOPIC also supports the ability to search for words and/or phrases in specific "header" fields,
such as document title, document type, status, etc. This type of query is called a form query, because the
input screen looks like a structured form. When using a form query, the upper pane of the TOPIC Query
Entry screen (Figure 2-25) contains a list of available fields, each with its own entry field. For each header
field and its associated entry field, there is an option labeled Require. If this option is selected for a field,
the field will be required for the search to be satisfied. Otherwise, the field will be considered optional.

2.8.4.1 Selecting the Form Query Entry Mode

TOPIC normally starts in simple query mode. The first query screen will be formatted to accept
simple queries. To enter a form query, change toform Query mode.

To change TOPIC to form query mode:

1. Select the Query entry from the menu bar of the TOPIC Main Menu screen. A pull-down
menu appears with various query options (Figure 2-19).

2. Select the Query Type entry from the Query pull-down menu. A cascading menu appears
listing the available types of queries (Figure 2-21). The type of query currently selected is
indicated with a shaded radio button.

3. Select the Eorm Query entry from the Query Type cascading menu. The Query pull-down
menu disappears, and the upper pane of the TOPIC Query Entry screen changes to accept
a form query (Figure 2-25).
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Figure 2-25. TOPIC--entry screen for form queries

I

2-32



2.8.4.2 Using a Form Query

Words and/or phrases may be entered into a form query just as in a simple query, but the words
and/or phrases are associated specific fields. Thus, if the word "earthquakes" is searched for in the Title
field, the resulting query will select all documents with the word "earthquakes" in the title.

To enter search information into a form query:

1. Enter the search word(s) and/or phrase(s) in the entry field next to the desired header field.

2. Select the Require option for the field if the search information is required rather than
optional.

3. Repeat Steps 1 and 2 for each desired field.

4. When the search information for all desired fields has been entered, press the [Return] or
[Enter] key or select the Retrieve push-button to start the query retrieval.

2.8.5 Selecting Documents for Viewing from the Results List

As a query runs, two pieces of information are updated in the status area immediately below the
Query Entry pane. On the left of the status area, there is a message that displays the number of records
selected out of the number of records that have been examined. On the right of the status area, there is a
bar-indicator that fills with color, left to right, to indicate the percent of the query completed. When the bar
is completely filled with color, the search has completed, and a brief description of the selected documents
will appear in the results list located immediately below the status area (see Figure 2-26, which illustrates a
typical results list following a simple query).

The results lists contains the following information about each selected document:

DOCUMENT SET-A code indicating the type of document (e.g., NTD, LLW, TDI, NIST, etc.).

DOCUMENT DATE-The date of the document.

TITLE-The title of the document appears in this field. Note that the title may be too long to
display within the results list pane. If this is the case, select and move the horizontal scroll bar
indicator at the bottom of the results list to shift the display left or right as needed.

To select a document in the results list for viewing:

1. Select the desired entry in the results list. The selected document is retrieved and displayed f

in a separate window.

2. To view more than one document at a time, position the cursor and select additional
documents. Each document is displayed in its own window.

3. The TOPIC window may be maximized to include the entire screen.
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Figure 2-26. TOPIC-query results list

4. The individual document windows may be moved around within the TOPIC window to,
permit viewing of two or more documents concurrently. To move a document window:
(i) position the cursor on the title bar, (ii) press and hold the mouse button, (iii) drag the
window to the desired location, and (iv) release the left mouse button to leave the window
in its new position.

2-34



2.8.6 Viewing Selected Documents

When a document has been selected from the results list for viewing, it will appear in a display
window. The search term(s) used to retrieve the document will be highlighted (Figure 2-27), and
"navigation" facilities are provided to permit a rapid "jump" through the document display to the next or
previous occurrence of the search term.

To search for the next or previous occurrence of the search term:

1. Select the Navigate options from the menu bar of the TOPIC Main Menu. The system
displays the Navigate pull-down menu (Figure 2-28).

2. To find the next search term, select Next Highlight.

3. To find the previous search term, select PreviQus Highlight.

Facilities are provided to search for additional words and/or phrases that were not used as
original search terms.

To find additional words and/or phrases in the text:

1. Select the Navigate option from the menu bar of the TOPIC Main Menu.

2. Select the Eind Text entry in the Navigate pull-down menu. Another entry window is
displayed where the word(s) or phrase(s) that are to be found can be entered (Figure 2-29).

3. Enter the desired word(s) or phrase(s), and select Find Next to find the next occurrence or
Find Previous to find the previous occurrence.

4. Select Dismiss to exit from the text search window.

Facilities are also provided to display the next or previous document in the selection list.

To display the next or previous document in the selection list:

1. Select the Navigate option from the menu bar of the TOPIC Main Menu.

2. To display the next document in the selection list, select Next Document.

3. To find the previous document in the selection list, select PreviQus Document.
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2.8.7 Launching WordPerfect

A document that has been selected for display may be viewed and/or edited in a file with
WordPerfect. While documents in the TDOCS may be edited using WordPerfect, they may not be saved
directly into the TDOCS. However, the user may freely access records from the TDOCS, modify them,
incorporate them into other work products, and save them on a local hard disk or a diskette.

When a document has been selected for display using the TDOCS search facilities, an icon and
descriptive line (i.e., Edit document) appears at the top of the document. If this icon is clicked upon, the
system will start a WordPerfect session in another window using the selected document. WordPerfect
functions can then be performed on this document. If the results of the WordPerfect session are saved, the
WordPerfect save action will not modify the record in the TDOCS.

2.8.8 Displaying Images

Many documents contain graphical images, figures, etc., that may be displayed through the
image display facilities of TOPIC. Images and text are stored in different formats, and a special facility is
required to display images. The normal TOPIC display for documents includes the text and icons
representing any graphical images. Figure 2-30 illustrates a document that contains an image represented
by an icon embedded in the text. If an image icon is clicked upon, the system will start the image viewer in
another window using the selected image (Figure 2-31).

To view an embedded image from a TOPIC document display:

1. Click on the icon for the desired image. The system displays the image in a separate
window.

2. When finished viewing the image, close the image window by clicking on the upper left
comer of the window and selecting Close from the pull-down menu.
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2.8.9 Exiting From the Record Search Facility

To exit from the Search facility:

1. Select the Eile entry in the menu bar at the top of the TOPIC Query Entry screen. The system
displays the Eile pull-down menu.

2. Select the Eiit entry from the Eile pull-down menu. TOPIC displays a message asking
whether to save or discard the current query and waits for a response (Figure 2-11).

3. In most cases, it is not desirable to save the current query. Select the Discard push-button
under the message. The TOPIC full-text search and retrieval environment terminates, and the
TDOCS Main Menu displays again.

2.9 MAIN MENU-HELP ENTRY

The TDOCS provides on-line help for that is configured to reflect the individual user's
authorities and permissions.

To access the on-line Help from the TDOCS Main Menu:

1. Select Help from the menu bar of the TDOCS Main Menu (Figure 2-4). A Help pull-down
menu appears with entries for Help and About (Figure 2-32).

2. Select Help, or press the mnemonic key [h] or the accelerator key [Ctrl+H], the Help Index
screen appears, allowing selection of help topics.

3. Select the About entry, or press the mnemonic key [a], a description of the TDOCS is
displayed.

To use the Help entry in the Help pull-down menu:

1. Select the Help entry from the Help pull-down menu (Figure 2-32). The Help Index
window is displayed (Figure 2-33).

2. Select the desired entry from the Help Index window and press the OK push-button to
display the help topics for that entry.

Similar help functions are available from all other TDOCS and TOPIC full-text search screens.

Figure 2-32. TDOCS-Help pull-down menu
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Figure 2-33. Help Index window
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APPENDIX A

ERROR MESSAGES



A ERROR MESSAGES

Custodian/administrator assistance is available at the following phone numbers:

* Nuclear Regulatory Commission System Administrator (310) 415-8087(8:00 a.m. - 5:00 p.m., EST)

* Center for Nuclear Waste Regulatory Analyses Help Desk (210) 522-5258(8:00 a.m. - 5:00 p.m., CST)

ERROR MESSAGE ERROR INFORMATION/USER ACTION
Bad working directory. Server cannot change to proper directory. Contact the

database custodian/administrator and report the error
message.

Client file error (%Id). Cannot save file to local disk: (i) use the owner account
(permissions), or (ii) clean off the disk.

Client Memory Error. Client out of memory. Close some applications.

Could not write document. Contact the database custodian/administrator and report
the error message.

Document synchronization failed Retry the operation. If the problem reoccurs, verify that
the server is up and functioning. If the network
connection is up and functioning, and the problem
persists, contact the database custodian/administrator and
report the error message.

Error connecting to server. Server is not functioning. Contact the database custodian/
administrator and report the error message.

Input Data Too Long. Input data too long for field(s). Re-enter abbreviated
form of data.

Invalid Document Type. Unknown document type passed to server. Contact the
database custodian/administrator and report the error
message.

No more records. Contact the database custodian/administrator and report
the error message.

RPC Call timed out. System error. Contact the database custodian/
administrator and report the error message.

Server File Error (%Id). Cannot read/write file. Contact the database custodian/
administrator and report the error message.

Server list data error. Contact the database custodian/administrator and report
the error message.
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ERROR MESSAGE ERROR INFORMATIONIUSER ACTION

Server Memory Error. Server out of memory. Contact the database custodian/
administrator and report the error message.

SQL Error (%Id). System error. Improper installation. Contact the database
custodian/administrator and report the error message.

Unable to find rpc. dli. Contact the database custodian/administrator and report
the error message.

Unknown Server Error. Contact the database custodian/administrator and report
the error message.

Version Error Installation problem. Contact the database custodian/
administrator and report the error message.
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